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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK Playback application provides the capability to play back data stored in data 

recording files. 

 

The topics in this user guide require an understanding of the topics covered in the TReK 

Concepts document.  Please be sure you have read the TReK Concepts document before 

reading this user guide. 

 

1.1 Getting Started 

Start with the Introduction which provides an application overview.  Next, try the Quick 

Start Guides for “How Tos” for common functions.  For help with details, reference the 

Details section.  See the FAQ and Troubleshooting section for helpful hints and solutions 

to the common “gotchas”. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:            trek.help@nasa.gov 

Telephone:      256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time) 

Fax:                 256-544-9353 

 

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time.  The HOSC Help Desk (256-544-5066) can provide assistance as needed 

and is available 24x7. 

 

 

3 Introduction 

The TReK Playback application provides the capability to play back data stored in data 

recording files and forward the data.  The TReK Data application can be used to receive 

the forwarded data and perform any of the functions available in the data application such 

as processing the data and displaying it.  The configuration of the TReK Playback 

application can be saved. 
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4 Overview of the User Interface 

4.1 Main Window 

The main window is shown in Figure 1.  The main window consists of two areas.  The 

top part of the main window contains statistics information about the playback in 

progress.  It will be empty until a playback is started.  The bottom part of the window is a 

message area that is used to display important status and information messages about the 

activities in progress.   

 

The Message Area is a dock window that you can float or dock.  To float a dock window, 

use your left mouse button to click and hold the title area while dragging the window to 

another area of the screen.  To dock, use the title bar to drag the dock window over the 

main window and drop. 

 

 

Figure 1 Main Window 

 

Configuration Toolbar 

The Configuration toolbar provides the capability to configure the playback, Activate the 

playback, and Deactivate the playback. 

 

Playback Toolbar 

The Playback toolbar provides access to the playback controls.  The control buttons 

provide the capability to Start, Pulse, Pause, or Stop a playback.  The Status area to the 

right of the controls displays the status of the playback. 

 

Statistics Area 

The Statistics area provides real time statistics information for active services. 
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Message Area 

The Message Area displays important information, warning and error messages.  The 

message area can be cleared using the View menu. 

 

4.2 Menus 

The application menus are:  File, View, Playback, Options, and Help.  Each of these 

menus is described in more detail below. 

 

File Menu 

The File menu provides the capability to create a new configuration, open a 

configuration, save a configuration, and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide the statistics area and the main window message area.   

 

Playback Menu 

The Playback menu provides the capability to configure, activate, and deactivate a 

playback.  Once a playback has been activated, the Playback menu will also display menu 

items to control the playback. 

   

Options Menu 

The Options menu provides the capability to access statistics, reset statistics, and 

configure statistics snapshot recording.  It also provides access to the Messages dialog 

which can be used to display and filter application messages.   

 

Help Menu 

The Help menu provides access to on-line help and application version information. 

5 Quick Start Guides 

This section provides “How Tos” for common functions. 

 

5.1 How to Configure the Playback 

This section describes how to configure the application to play data back from recorded 

data files.  For additional information and details about the Configure dialog please 

reference section 6.1. 

 

1. To configure a playback push the Configure button. 

2. In the configure dialog use the Playback tab to add one or more recorded data files.  

Update other playback configuration information such as Playback Order, Playback 

Rate, or Playback Mode as needed. 

3. In the Configure dialog use the Forward tab to enter one or more destinations for the 

data to be played back. 



TREK-USER-0016 

 4 

4. Push the Ok button to complete the configuration.  The Configuration status should 

turn green. 

 

 

5.2 How to Activate a Playback 

This section describes how to activate a playback.  A playback must be configured in 

order to activate it. 

 

1. To activate a playback push the Activate button. 

 

5.3 How to Deactivate a Playback 

This section describes how to deactivate a service.  A playback must be activated in order 

to deactivate it. 

 

1. To deactivate a playback, push the Deactivate button. 

 

 

6 Details 

This section covers various application details. 

6.1 Configure Dialog 

The Configure dialog is used to configure a playback.  The Configure dialog is shown in 

Figure 2.  Details are provided below. 

 



TREK-USER-0016 

 5 

 

 

 

Figure 2 Configure Dialog 

 

There are three tabs in the Configure dialog:  Playback, Forward and Cryptography.  The 

Playback tab is used to configure the playback, the Forward tab is used to configure data 

forwarding, and the Cryptography tab is used to configure cryptography settings. 

6.1.1 Configure Dialog (Playback Tab) 

The Playback tab is shown in Figure 3.  It is used to enter information about the 

playback.  It has two tabs: General and Decrypt.  The General tab is used to enter 

playback settings and the Decrypt tab is used to enter information needed to decrypt 

encrypted recorded data files.   
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Figure 3 Configure Dialog Playback Tab 

 

Configure Dialog (Playback Tab [General Tab]) 

The General tab is shown in Figure 4.   

 



TREK-USER-0016 

 7 

 

 

Figure 4 Configure Dialog (Playback Tab [General Tab]) 

 

The fields in the General Tab are described below. 

 

Files 

Files containing recorded data can be identified by browsing for the files and adding them 

to the list.  The Browse button will display an Open dialog which can be used to select 

one or more files and add them to the list.  Figure 5 shows the Files list after a single 

recorded data file was selected and added to the list.  The Delete button can be used to 

delete one or more files from the list.  If the directory containing the recorded data file 

does not have an associated configuration file describing the recorded data file’s format, 

the Packet Type will show “UserDefined” when the recorded data file is added to the list.  

If this occurs, the Update Packet Type button can be used to identify the type of data in 

the recorded data file(s) selected.  The Playback library identifies configuration files, in a 

record file directory, by the file name which is a combination of the record file’s base file 

name with a “.con” extension.  The configuration file associated with a record file uses a 

packet header processor template to record information on how to determine the length, 

packet sequence count and embedded time of each recorded packet.   
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Figure 5 Configure Dialog (Playback Tab [General Tab] Files) 

 

Working with Encrypted  Recorded Data Files  

If the recorded data file selected is encrypted and a configuration file exists, the Packet 

Type is set to Encrypted.  If the recorded data configuration file is missing, the Packet 

Type will default to UserDefined.  Since the recorded data file contains encrypted data, 

the Update Packet Type dialog should be used to set the packet type to Encrypted. 

 

The following scenarios describe what default packet type will be displayed based on 

several different factors and whether you need to take any action to update the packet 

type. 

 

Scenario 1 

Recorded Data File Contains:    PdssPayload 7 Data 

Is Data Encrypted?     No 

Does Recorded Data Configuration File Exist? Yes 

When File is Added Packet Type Displayed:  PdssPayload 

Action: 

No Action is necessary since the default packet type displayed is correct.  The data being 

played back is unencrypted PdssPayload data. 

 

Scenario 2 

Recorded Data File Contains:    PdssPayload 7 Data 

Is Data Encrypted?     Yes 
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Does Recorded Data Configuration File Exist? Yes 

When File is Added Packet Type Displayed:  Encrypted 

Action: 

No Action is necessary since the default packet type displayed is correct.  The data being 

played back is encrypted data. 

 

Scenario 3 

Recorded Data File Contains:    PdssPayload 7 Data 

Is Data Encrypted?     No 

Does Recorded Data Configuration File Exist? No 

When File is Added Packet Type Displayed:  UserDefined 

Action: 

Use the Update Packet Type dialog to change the packet type to identify the type of data 

in the recorded data file (PdssPayload) since the data being played back will be 

unencrypted PdssPayload data. 

  

Scenario 4 

Recorded Data File Contains:    PdssPayload 7 Data 

Is Data Encrypted?     Yes 

Does Recorded Data Configuration File Exist? No 

When File is Added Packet Type Displayed:  UserDefined 

Action: 

Use the Update Packet Type dialog to change the packet type to identify the type of data 

in the recorded data file (Encrypted) since the data being played back will be encrypted 

data. 

 

 

Ignore Start/Stop Times on Individual Files and Synchronize Playback Using This Master 

Start/Stop Time 

The default configuration for a playback will play back the recorded data one file at a 

time.  If this checkbox is checked, the playback will be ‘synchronized’ such that the data 

in the total set of recorded data files will be playback based on time and not based on 

individual files. 

 

Start Time 

The Start Time for the synchronized playback. 

 

Stop Time 

The Stop Time for the synchronized playback. 

 

Playback Order 

There are three options for Playback Order.  Each is described below: 

 

Order Received 

Order Received will playback files in the order they were added to the list and playback 

packets in the files in the order they were recorded in the file. 
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Reorder Using Embedded Time 

Reorder Using Embedded Time will playback packets from the playback files in time 

order using the embedded time stamp in the individual packets.  A reorder queue is 

required if packets in the individual playback files are out of order.  The reorder queue 

must be sized to hold the maximum sequence of out of order packets in the playback files 

or the packets will not be reordered correctly.  For example, packets 

A,B,C,D,M,N,O,E,F,G,H,I,J,K,L,P,Q,R in a file would require a reorder queue size of 

four to produce the proper packet sequence of A,B,C,D,E,F,G,H,I,J,L,K,M,N,O,P,Q,R. 

 

Reorder Using Embedded Time And Remove Duplicates 

Reorder Using Embedded Time will playback packets from the playback files in time 

order using the embedded time stamp in the individual packets.  Duplicate packets will 

not be played back.  Duplicate packets are identified using the packet’s embedded time 

and sequence count.  A reorder queue is required if packets in the individual playback 

files are out of order or contain duplicate packets.  The reorder queue must be sized to 

hold the maximum sequence of out of order packets or duplicate packets or the packets 

will not be played back correctly. For example, packets 

A,B,C,D,M,E,F,G,H,I,J,K,L,M,N,O,P,Q,R in a file would require a reorder queue size of 

two to produce the proper packet sequence of A,B,C,D,E,F,G,H,I,J,L,K,M,N,O,P,Q,R. 

 

Reorder Queue Size 

Reorder Queue Size is the size of the queue used to reorder the packets in a playback file.  

Doubling the maximum packet sequence error associated with the playback file is a 

method that may be used to estimate a reorder queue size.  If the reorder queue size is too 

small, packets will not be reordered in the proper sequence.  If the reorder queue size is 

too large, CPU will be taxed unnecessarily. 

 

Playback Rate 

There are three options for playback rate.  Each are described below: 

 

Packets/Sec 

Packets per Second will be play the recorded data back using the # packets per second 

rate entered. 

 

Bits/Sec 

Bits per Second will be play the recorded data back using the # bits per second rate 

entered. 

 

Native Scale 

Native Scale will play the recorded data back at a specified multiple of the packet’s  

native rate.  Native rate is determined by the embedded time stamp associated with each 

packet 
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Playback Mode 

The playback can be configured to play back indefinitely or a specific number of times.  

If the playback is set to ‘Indefinitely’ the playback will continue to replay the playback  

until the playback is stopped using the Stop Playback command. If it is set to Specific # 

Times, the playback will be run the specific number of times identified. 

 

Playback Pulse 

When the playback is pulsed, the # packets sent per pulse is defined by this entry. 

 

Configure Dialog (Playback Tab [Decrypt Tab]) 

The Decrypt Tab is shown in Figure 6. 

 

 

Figure 6 Configure Dialog (Playback Tab [Decrypt Tab]) 

 

 

The fields in the Decrypt Tab are described below. 

 

Decrypt Recorded Data Checkbox 

The Decrypt Recorded Data checkbox is used to identify that the recorded data should be 

decrypted as it is played back.  If decryption is used the Cryptography tab must be 

populated with the information needed to perform the decryption. 

 

Peer Public Key Pathname List 
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To decrypt recorded data during the playback, the TReK software needs the Peer Public 

Key for the encrypted data.  To decrypt data, the Decrypt Recorded Data checkbox 

should be checked and the Peer Public Key should be entered for each playback file that 

needs to be decrypted.  The Set Peer Public Key button is used to browse the local disk 

for a peer public key file.  The Delete button is used to Delete an entry.  One or more 

rows must be selected to use the Delete and Peer Public Key buttons. 

 

6.1.2 Configure Dialog (Forward Tab) 

The Configure Dialog Forward Tab is shown in Figure 7.  It is used to configure settings 

for forwarding data.  The Forward tab contains three tabs:  Destination List, Transform, 

and Encrypt. 

 

 

Figure 7 Configure Dialog Forward Tab 

 

Configure Dialog (Forward Tab [Destination List Tab]) 

The Destination List Tab is shown in Figure 8. 
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Figure 8 Configure Dialog (Forward Tab Destination List Tab) 

 

Destination List 

The destination list is used to identify the list of destinations to which the data should be 

forwarded.  Data can be forwarded to a network destination or a Delay Tolerant Network 

(DTN) destination. 

 

A network destination example is shown in Figure 9.  For a network destination, each 

destination must include a user defined name that is unique in this destination list, a 

Protocol, and the applicable settings required for the protocol selected. The Protocols 

supported are UDP and TCP.  The Protocol menu provides the capability to select the 

type of socket to use when forwarding the data:  UDP, TCP Client, or TCP Listener 

socket.  Figure 9 shows three different destinations in the Destination List.   When using 

a TCP Listener socket it is not necessary to define a Destination IP Address or a 

Destination Port.  When the Local Port is set to 0, the operating system will automatically 

select a port to use for the socket that is created to send data to the destination.  This is 

the default as it saves you the trouble of keeping up with ports.  However, you can enter a 

specific port if you would like.  This is advisable if you are using a TCP Listener socket 

since another party will be connecting to the socket.  The + and - buttons are used to add 

a row to the list and delete a row from the list respectively. 

 

A DTN destination example is shown in Figure 10.  For a DTN destination, each 

destination must include a destination node number and a destination service number.  

General properties that must be input for all DTN destinations include Source Service 
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Number, Lifespan, Bundle Protocol Class of Service, Expedited Priority Ordinal, 

Transmission Mode, and Criticality. 

 

 

Figure 9 Configure Dialog Forward Tab Network Destination List Tab Populated 
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Figure 10 Configure Dialog Forward Tab DTN Destination List Tab Populated 

 

 

Configure Dialog (Forward Tab [Transform Tab]) 

The Transform tab is shown in Figure 11.  The Transform tab provides the capability to 

enable the transform feature which can be used to remove a specific number of bytes 

from the beginning of each packet before the packet is forwarded. 
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Figure 11 Configure Dialog Forward Tab Transform Tab 

 

Configure Dialog (Forward Tab [Encrypt Tab]) 

The Encrypt Tab is shown in Figure 12.  The Encrypt tab provides the capability to 

encrypt data before it is sent to a destination.  Encryption is controlled per destination.  

The Peer Public Key associated with a destination must be provided in order to send 

encrypted data to the destination. 
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Figure 12 Configure Dialog Forward Tab Encrypt Tab 

 

The Peer Public Key Pathname list is populated using the Destination List.  To encrypt 

data going to a specific destination, check the Encrypt Outgoing Data checkbox, and 

identify the absolute path to the Peer Public Key associated with the destination.  The Set 

Peer Public Key button is used to browse the local disk for a peer public key file.  The 

Clear Peer Public Key button is used to clear a peer public key pathname.  One or more 

rows must be selected to use the Set Peer Public Key and Clear Peer Public Key buttons. 

 

6.1.3 Configure Dialog (Cryptography Tab) 

The Configure Dialog Cryptography Tab is used to configure cryptography settings when 

cryptography services are in use.  It is shown in Figure 13.   The Cryptography checkbox 

must be checked and all required cryptography settings must be populated with valid 

information in order to successfully activate a playback that uses cryptography 

capabilities. 
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Figure 13 Configure Dialog (Cryptography Tab) 

 

Each field is described below. 

 

Cryptography Checkbox 

The Cryptography checkbox is used to specify you want to use cryptography services.  

 

Public Key Pathname 

This is the absolute path for the public key file. 

 

Private Key Pathname 

This is the absolute path for the private key file. 

 
Use Passphrase 

The Use Passphrase checkbox is used to specify that the private key requires a passphrase.  If 

this box is checked, the passphrase must be entered into the text field.  The passphrase text 

will not be displayed in the clear.  If you want to see the text entered in the clear, check the 

Show Text checkbox.  This information is not stored when you save a configuration.  You 

will have to enter it each time you restart the application when using cryptography services. 

 

Show Text 

The Show Text checkbox is used to display the passphrase text in the clear. 

 

Cipher Class 

This option menu is used to select the cipher class. 
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Packet Key Encryption Period 

The Packet Key Encryption Period is only used when using the Packet encryption feature.  

As mentioned in the TReK Cryptography Services Tutorial, cryptography keys are used 

to generate other keys behind the scenes.  One of these keys is called a Cipher Encryption 

Key (CEK).  The Packet Key Encryption period defines how often to generate a new 

Cipher Encryption Key (CEK) when streaming encrypted data.  It can be configured to 

generate a new CEK for a packet stream once every "x" seconds to support encryption of 

high rate packet streams.  The time period is measured in seconds.  If the packet key 

encryption period is set to zero, the TReK encryption library will generate a new packet 

encryption key for every packet in the stream.  The TReK encryption library can support 

the encryption of high rate packet streams by setting the packet key encryption period to 

a non-zero value.  The default value is 10 seconds. 

 

 

6.2 Statistics 

Statistics displays statistics information as the data playback is in progress.  Statistics 

information is displayed in the Main Window and in the Statistics dialog available from 

the Options menu.  Figure 14 shows the Statistics area in the Main Window.  Figure 15 

shows the Statistics dialog. 

 

 

 

Figure 14 Statistics in the Main Window 
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Figure 15 Statistics Dialog 

 

 

Statistics can be configured to display different views of the statistics information.  The 

view options can be accessed using the Statistics area pop-up menu.  The pop-up menu is 

shown in Figure 16 and can be accessed by clicking the right mouse button in the 

statistics area.  

 

 

Figure 16 Statistics Pop-Up Menu 

 

The Statistics pop-up menu has several options.  Each is described below: 

 

Show Service Statistics 

Service Statistics is the default view.  It is shown in Figure 14.  This view shows statistics 

associated with the playback service.  You can expand the Playback Service item to see 

information about playback packets.   

 

Show Service Device Statistics 

Service Device Statistics shows the same information as Service Statistics with the 

addition of devices that are used by the service.  Figure 17 shows an example.  In this 
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view you can see the service is configured to play back PdssPayload.RT.PL.7 packets and 

forward the packets using a unicast socket.  Figure 18 shows the view after some data has 

been played back.   

 

 

Figure 17 Service Device Statistics 

 

 

Figure 18 Service Device Statistics After Starting the Playback 

 

Each row in Figure 18 is described below: 

 

Playback Service:  Indicates that seven packets were played back and seven packets were 

forwarded. 

 

PdssPayload.RT.PL.7:  Indicates that seven packets that matched this packet key were 

played back. 
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4.PlaybackServicePlaybackLibrary:  This item is a playback library device created 

behind the scenes to play back data from the recorded data files.  This shows that seven 

packets were played back by the playback library device. 

 

1.1.127.0.0.1.51494.1:  Indicates that seven packets were forwarded using this unicast 

socket. 

 

 

Show Device Statistics 

Device Statistics displays all the network sockets or devices in use by the playback.  

When the device is a network socket it will include the IP address and Port.  When the 

device is a library device that performs a specific function such as the playback, the name 

will reflect the device’s function.  Figure 19 shows the device statistics view.  In this 

example, there is one network socket displayed.  This socket is used to forward the data.  

When the playback is active, the Pkts Sent column will update reflecting the number of 

packets sent.  The PlaybackServicePlaybackLibrary line item represents the device used 

to perform the playback.   When the playback is active, the Pkts Sent column will update 

reflecting the number of packets played back. 

 

 

Figure 19 Device Statistics View 

 

Show Device and Packet Statistics 

The Device and Packet Statistics option will display both device statistics and packet 

statistics.  Figure 20 shows the device and packet statistics view expanded.  When this 

data is played back the Pkts sent column will update reflecting the number of packets 

played back and the number of packets forwarded for each device and packet key.  
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Figure 20 Device and Packet Statistics 

 

 

Show Snapshot Statistics 

Figure 21 shows the Snapshot view.  This view provides a snapshot of the current state of 

the packets being played back. In Figure 21 you can see one packet that is blue.  Blue 

indicates the playback is configured to play the packet back but it is not currently being 

played back.  Green indicates the packet is being played back.  

 

 

Figure 21 Snapshot Statistics 
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Show Debug Statistics 

The Debug Statistics view shows the most detailed information of all the various views.  

It shows device statistics and packet statistics for the playback.  The Debug Statistics 

View is shown in Figure 22. 

 

 

Figure 22 Debug Statistics View 

 

 

Expand All 

The Expand All option will expand the Statistics tree to show all items.  The Statistics 

tree will only appear for views that show packet statistics (e.g. ‘Device and Packet 

Statistics’ view). 

 

6.2.1 Configure Statistics Dialog 

The Configure Statistics Dialog is context dependent based on the current statistics 

configuration.  It provides the capability to show and hide columns.  Each configuration 

is described below. 

 

Service and Service Device Statistics Configuration 

The Configure Statistics Dialog shown in Figure 23 is displayed when the statistics 

configuration is set to Service Statistics or Service Device Statistics. 
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Figure 23 Configure Statistics Dialog (Service and Service Device) 

 

Each field is described below. 

 

Name 

Name will always be set to “PlaybackService”and cannot be turned off.  

 

Item Type 

Item Type identifies the type of item for which statistics are being provided.  In the 

Service Statistics view types include Service and Packet Key.  In the Service Device 

Statistics view you will see additional devices such as socket devices and library devices. 

 

Packet Type 

Packet Type corresponds to the types of packets contained in the recorded data files 

identified on the Configure dialog. 

 

Service Function Columns 

The Source and Forward columns provide statistics associated with specific functions.  

For example, the Source column indicates how many packets have been played back and 

the Forward column indicates how many packets have been forwarded. 

 

Configure Statistics (Device Statistics, Device and Packet Statistics, Debug Statistics) 

The Configure Statistics Dialog shown in Figure 24 is displayed when the statistics 

configuration is set to Device Statistics, Device and Packet Statistics, or Debug Statistics.   
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Figure 24 Configure Statistics (Device, Device and Packet, Debug) Dialog 

 

Each field is described below. 

 

Name 

Name is a character string that uniquely identifies each device and packet type.  The 

device name is the device key if no device name is provided when the device is created.  

The packet name is the packet key associated with the packet.   

 

State 

State is the current state or condition of a device.  Valid states include Start, Stop, 

Pause, Pulse, Ready and Undefined.  If you check the State checkbox, the State column 

will be displayed. 

 

Packet Type 

Packet Type is a character string identifying the configuration of a device’s packet header 

processor.  If a device does not have to have an associated packet header processor, the 

Packet Type column is blank.  Packet header processors process individual fields in the 

packet header producing packet keys.  If you check the Packet Type checkbox, the Packet 

Type column will be displayed. 

 

Receive State 

Receive State is the current receive state of an object.  Valid receive states include Ready 

To Receive, Receiving and Not Receiving. If you check the Receive State checkbox, the 

Receive State column will be displayed. 
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Send State 

Send State is the current receive state of an object.  Valid receive states include Ready To 

Send, Sending and Not Sending. If you check the Send State checkbox, the Send State 

column will be displayed. 

 

Device Key 

Device Key is a character string that uniquely identifies each device.  If you check the 

Device Key checkbox, the Device Key column will be displayed. 

 

Pkts Rcvd  

Packets received represents the number of packets received.  If you check the Pkts Rcvd 

checkbox, the Pkts Rcvd column will be displayed. 

 

Pkts Sent 

The number of packets sent to a destination. If you check the Pkts Sent checkbox, the 

Pkts Sent column will be displayed. Pkts Sent is not the same as packets forwarded. Pkts 

Sent is used to represent the number of packets sent across a socket that is configured to 

receive and send packets. Pkts Sent never indicates packets forwarded. To see the number 

of packets forwarded, look at the Pkts Fwd column on the Port Tab. 

 

Seg Rcvd 

Segments Received represents the number of segments received.  This column is only 

applicable for TCP.  If you check the Seg Rcvd checkbox, the Seg Rcvd column will be 

displayed. 

 

Queue Size 

Queue Size is the size of the queue that temporarily buffers packets that are being 

processed by a device.  A device does not have to be associated with a queue.  The 

device’s queue size is defined when the device is created.  If you check the Queue Size 

checkbox, the Queue Size column will be displayed. 

 

Host Name 

Host Name is a unique identifier that serves as the name of the computer. If you check 

the Host Name checkbox, the Host Name column will be displayed. 

 

IP Address 

IP Address is the IP address of a device if the device is a socket.  If you check the IP 

Address checkbox, the IP Address column will be displayed. 

 

Port 

Port is the port number of the device if it is a socket.  The port number is a string 

identifying the type of socket (e.g., client, listener or server) formatted as “c/l/s”.  If the 

socket is a client socket then the port number will be followed by two "/" (e.g., 6100//).  

If the client socket is connected to a listener socket, the listener's port number is also 

listed (e.g., 6100/5432/).  If the socket is a server socket then the client port number that 

is connected to the server is listed first, followed by two "/" and the server's listener port 
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number (e.g., 6100//7890).  If the socket is a listener socket the listener's port number is 

listed between two "/" (e.g., /5555/).  If you check the Port checkbox, the Port column 

will be displayed. 

 

Protoface 

Protoface is the IP transportation protocol, either TCP or UDP, of a socket device.  If you 

check the Protoface checkbox, the Protoface column will be displayed. 

 

Recv Pkt Rate 

Receive Packet Rate represents the number of packets received in the last second.  If you 

check the Recv Pkt Rate checkbox, the Recv Pkt Rate column will be displayed. 

 

Max Recv Pkt Rate 

Maximum Receive Packet Rate represents the maximum packet rate seen thus far.  If you 

check the Max Recv Pkt Rate checkbox, the Max Recv Pkt Rate column will be 

displayed. 

 

Recv kbit Rate 

Receive kilobit Rate represents the current number of kilobits per second that are being 

received.  If you check the Recv kbit Rate checkbox, the Recv kbit Rate column will be 

displayed. 

 

Max Recv kbit Rate 

Maximum Receive kilobit Rate represents the maximum kilobit rate seen thus far.  If you 

check the Max Recv kbit Rate checkbox, the Max Recv kbit Rate column will be 

displayed. 

 

Send Pkt Rate 

Send Packet Rate represents the number of packets sent in the last second.  If you check 

the Send Pkt Rate checkbox, the Send Pkt Rate column will be displayed. 

 

Max Send Pkt Rate 

Maximum Send Packet Rate represents the maximum packet rate sent thus far.  If you 

check the Max Send Pkt Rate checkbox, the Max Send Pkt Rate column will be 

displayed. 

 

Send kbit Rate 

Send kilobit Rate represents the current number of kilobits per second that are being sent.  

If you check the Send kbit Rate checkbox, the Send kbit Rate column will be displayed. 

 

Max Send kbit Rate 

Maximum Send kilobit Rate represents the maximum kilobit rate sent thus far.  If you 

check the Max Send kbit Rate checkbox, the Max Send kbit Rate column will be 

displayed. 
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Rcvd Pkts Drop 

Received Packets Dropped represents the number of packets that TReK received and then 

dropped.  If you check the Rcvd Pkts Drop checkbox, the Rcvd Pkts Drop column will be 

displayed. 

 

Send Pkts Drop 

Send Packets Dropped represents the number of packets that TReK attempted to send but 

dropped.  If you check the Send Pkts Drop checkbox, the Send Pkts Drop column will be 

displayed. 

 

Pkts Drop 

Packets Dropped represents the number of packets that were dropped because they could 

not be processed by another device.  If you check the Pkts Drop checkbox, the Pkts Drop 

column will be displayed. 

 

Seg Drop 

Segments Dropped represents the number of segments that TReK received and then 

dropped.  This column is only applicable for TCP.  If you check the Seg Drop checkbox, 

the Seg Drop column will be displayed 

 

Pkt Seq Err 

Packet Sequence Error represents the number of packet sequence errors that occurred for 

a packet that is being received. A packet sequence error occurs when a packet arrives out 

of order (i.e. a packet with a sequence count of six was expected but instead a packet with 

a sequence count of seven was received). If you check the Pkt Seq Err checkbox, the Pkt 

Seq Err column will be displayed. 

 

Max Pkt Seq Err 

Maximum Packet Sequence Error represents the maximum packet sequence error that 

occurred for a packet that is being received. TReK determines the maximum packet 

sequence error by calculating the delta or difference between the expected packet 

sequence count and the actual packet sequence count. If you check the Max Pkt Seq Err 

checkbox, the Max Pkt Seq Err column will be displayed. 

 

Set To Defaults 

Set To Defaults will set all the fields to their default values. 

 

Configure Statistics (Snapshot Statistics) 

The Configure Statistics Dialog shown in Figure 25 is displayed when the statistics 

configuration is set to Snapshot Statistics.   
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Figure 25 Configure Statistics Dialog (Snapshot) 

 

Each field is described below. 

 

Number Columns 

Identifies the number of columns to display in a row. 

 

6.3 Configure Statistics Snapshot Recording Dialog 

The Configure Statistics Snapshot Recording dialog is shown in Figure 26.  Statistics are 

generated and captured in memory as you use the application.  A snapshot of the statistics 

can also be recorded to a file by turning on Statistics Snapshot Recording.   When 

Statistics Snapshot Recording is on, the snapshot is updated once a second with the latest 

statistics and written to a file.  Previous statistics snapshot information is overwritten 

each time the latest statistics information is written to the file.  Statistics are not available 

when the playback service is inactive.  If you deactivate the playback service before 

turning off Statistics Snapshot Recording, the statistics snapshot information will be 

empty. 
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Figure 26 Configure Statistics Snapshot Recording Dialog 

 

 

Each field is described below: 

 

Record Statistics Snapshot 

The Playback application provides the capability to write a snapshot of application 

statistics to a file.  If you check Record Statistics Snapshot, a snapshot of the application 

statistics will be written to the file specified. 

 

File Path 

The File Path should contain the absolute path to the directory where the statistics 

snapshot file should be written. 

 

File Name 

The File Name field should contain the name to use for the statistics snapshot file. 

 

Include Packet Statistics 

The Include Packet Statistics checkbox specifies whether packet statistics should be 

written to the file.   

 

 

6.4 Application Messages 

Various types of application messages are generated including information, progress, 

warning, error, and debug messages.  Application messages are stored in memory and 

written to a temporary log file.  The temporary log file is created on application 

initialization and exists as long as the application is running.  It is deleted when you exit 

the application.  The log file is located in the temporary directory provided by the 

operating system.  Only a subset of messages are stored in memory while all messages 

are written to the temporary log file.  The maximum number of application messages 

stored in memory is controlled by the message storage setting in the Configure Messages 

dialog.  Once the maximum is reached, older messages are deleted to make room for new 

messages.  Setting the maximum value to a large number can impact application 

performance since it will increase the amount of memory used by the application.  Setting 
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this number too low can cause you to miss important messages.  The application default 

was selected to protect against both of these scenarios.  Messages stored in memory are 

displayed in the Main Window Message Area and the Messages dialog.  The Messages 

dialog is shown in Figure 27.  The Main Window message area only displays Info, 

Warning, and Error messages.  The Messages dialog displays messages based on the 

display preferences defined in the Configure Messages dialog.  By default, the Messages 

dialog will display information, progress, warning, and error messages.  Columns in the 

Messages dialog can be sorted by clicking on the column header.  The Messages dialog is 

available from the Options menu.  progress, warning, and error messages.  Columns in 

the Messages dialog can be sorted by clicking on the column header.  The Messages 

dialog is available from the Options menu.   

 

 

Figure 27 Messages Dialog 

 

Configure 

The Configure button provides access to the Configure Messages dialog shown in Figure 

28.  This dialog provides access to preferences associated with messages.  Display 

preferences can be set to filter the types of messages (category) displayed in the 

Messages dialog.  Export Preferences control how the time tag is added to the filename 

that is created when messages are exported.  See the Export section for details.  Message 

storage defines the maximum number of messages that will be stored in memory while 

the application is running.  Once the maximum is reached, older messages are deleted to 

make room for new messages.  The Set to Defaults button can be used to reset these 

properties to application defaults. 
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Figure 28 Configure Messages Dialog 

 

 

Clear 

The Clear button provides access to the Clear Messages dialog shown in Figure 29.  This 

dialog provides two ways to clear application messages stored in memory.  You can clear 

all the messages or clear selected messages.  Once you clear messages, the messages are 

permanently deleted in all views (Main Window Message Area and the Messages dialog).   

 

 

Figure 29 Clear Messages Dialog 

 

 

Export 

The Export button provides the capability to save all the application messages currently 

in memory to a file.  When you push the Export button you will be prompted for a 

directory and filename.  Export will save all messages in memory, not just the messages 

currently displayed in the Messages dialog (i.e. the Display Preferences are not applied).  

The name you provide for the file will be modified with a time tag that is added to the 

filename.  The time tag indicates the time the file was closed.  The default is to append 

the time tag to the filename.  For example: 

 

Filename Input:   messages.txt 

Filename Output: messages_2017-05-07_13~03~28.txt 
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If you would like to prepend the time tag to the filename you can set this preference in 

the Configure Messages dialog.  This would result in the following: 

 

Filename Input:   messages.txt 

Filename Output: 2017-05-07_13~03~28_messages.txt 

 

 

Delog 

The Delog button provides the capability to save all application messages generated since 

the application was started.  Delog will retrieve the messages from the temporary log file.  

When you push the Delog button you will be prompted for a directory and filename.  A 

timetag is not applied to the filename. 

 

Filename Input:   messages.txt 

Filename Output: messages.txt 

 

6.5 Application Configuration File 

The Playback application saves the following information when you save a configuration:   

 

➢ Playback Configuration. 

6.6 Application Settings 

The Playback application saves application settings each time you exit the application.  

The next time you run the application, the application will initialize with the previous 

settings.  The following settings are saved: 

 

➢ Application Window Size 

➢ Configure Messages Selections 

 

6.7 Application Command Line Arguments 

The Playback application accepts the following command line arguments: 

 

➢ trek_playback.exe <filename> <passphrase> 

 

filename to open a configuration file (full path to file) 

 

passphrase to set the cryptography settings passphrase 

 

A value must be wrapped in double quotes if it contains spaces. 

 

Examples: 

 

➢ trek_playback.exe “D:/playback config.xml” 
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➢ trek_playback.exe D:/playback_config.xml topsecret 

 

 

If the configuration is valid, the application will automatically activate the playback 

service. 

 

7 FAQ and Troubleshooting 

This section addresses Frequently Asked Questions and provides tips for troubleshooting 

common gotchas. 

 

No FAQs Yet. 


